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Free template powerpoint medical

PowerPoint provides very useful resources, called templates, that automatically build the foundation and framework of a presentation. If you can't quite find the right one for you, you can create your own. This is how it happens. Create a custom PowerPoint template To create a custom PowerPoint template, you must first
open a blank presentation. To do this, click the File tab, and then click New in the left pane. A large template library appears, but since we are not looking for it, go ahead and select blank presentation. Next, you need to select the orientation and size of the slide. On the Design tab, in the Customize group, click the Slide
Size button. A small drop-down menu appears. Here, click customize slide size. The Slide Size dialog box appears. Here you can (1) adjust the height and width of the slide, or select a predefined option from the drop-down menu, and (2) select the orientation of the slide. The rest of the template creation is done in the
Slide Master in PowerPoint. You can use the slide master to customize the fonts, titles, and colors in your presentation in one place and apply the selections to all your slides. This allows you to maintain consistency across the template and remove the need to make changes on each individual slide. RELATED: Change
the default font in PowerPoint To apply a slide master, click the View tab, and then in the Master Views group, click Slide Master. The slide master appears in the left pane. The slide master is the top thumbnail displayed in the pane. Each sub-image represents each slide layout available in the theme. You make changes
to the slide master that affect each slide layout. This is where magic happens. First, you can choose a unique theme for your PowerPoint template. To do this, on the Slide Master tab, in the Edit Theme group, click Themes. A drop-down menu appears that introduces a wide range of themes to choose from. Each theme
has its own fonts and effects. Browse the collection and select the collection you want. You can also choose the background style for the theme you selected. In the Background group, click Background Styles, and then click the style that you want from the drop-down menu. If you want to customize the placeholders on
your slides, you can do so by selecting one of the options on the Insert Placeholder menu. You can find this option in the Main Layout group. After you select the slide to which you want to insert a placeholder from the box on the left and the type of placeholder you want to insert from the menu, click and drag the insertion
point to draw the placeholder pane. Repeat this process until you are satisfied with the template placeholder. When you're done with this, all you have to do is guarantee a custom template. Save a custom template to save a PowerPoint presentation (.pptx) as a template click the File tab, and then click the Save As
button. In the Other Locations group, click Browse. The Save As dialog box appears. Select the box next to the Save type box, and then in the list of options, click PowerPoint Template. When you select a file type for a PowerPoint template, PowerPoint redirects you to the Custom Office Templates folder. Here you want
to save your template. Click the Save button. The template will now be saved and ready for use. To find the template the next time you open PowerPoint, click the File tab, and then click New. Next, click the Custom tab, and then click Custom Office Templates. You will now see a custom template. Click to start using a
custom PowerPoint template. PowerPoint is the leading presentation program. However, the software can be expensive and is not the most versatile on the market. We looked at a number of PowerPoint options that are more cost-effective, easier to use, or include tools to create a more modern presentation to determine
the top six competitive options. Top 6 PowerPoint Options for Small Business Owners How We Evaluate Options for PowerPoint Above all, good options in PowerPoint should allow businesses to make powerful presentations with easy-to-use tools for creating, editing, and sharing slides. Alternatives should be more
affordable than PowerPoint, offer unique features, or both. Apps should also allow users to control how a slide show looks and behaves in terms of transitions and animations. PowerPoint option evaluation criteria include: Cost – The total cost of a platform should be affordable for most companies. Ease of use –
Presentation apps should be easy to use and understandable. Edit tools - This option allows users to add custom text, visualizations, or colors to their presentations. Templates – PowerPoint options should provide built-in templates for users who don't want to create presentations from scratch. Audience Interactivity – We
look for platforms that promoted audience feedback or allowed presenters to process questions or provide surveys during presentations. Presenter Tools – We compared notes, pointers, and narration options to help presentations be more effective. Based on the criteria above, we find that Google Slides is the best
choice for most small businesses looking for a powerpoint option. It is free to use and has all the tools you need to present powerful business presentations. It even allows the audience to ask questions and give notes and a virtual laser pointer to presenters. Best General PowerPoint Alternative for Small Businesses:
Google Slides Google Slides is part of your business productivity and also contains documents, tables, and forms. Google Slides is easy to use and includes robust tools to help you create presentations as you see fit. Way. Of all, it comes for free with personal Google accounts or is included in the paid G Suite service.
That's why Google Slides is our best overall choice for powerpoint options for small businesses thanks to collaboration and customization tools. Google Slides pricing Google Slides comes free with any personal Google account, and is also included in the G Suite platform for business email accounts that cost between $5
and $10 per user per month. All of our most compared apps have a free version, but only Slides offers all of its features regardless of the plan chosen. Pricing plans include: Personal Google Accounts: Free 15GB of storage G Suite Basic: $5 per user per month with 30GB of storage G Suite Business: $10 per user per
month with unlimited storage, activity reporting and retention policies In addition, 100GB of storage is available for $1.99 per month. Google Slides features With Google Slides, you can create and present slideshows quickly and easily, with plenty of templates to choose from. You can even import PPT files, so you can
access existing PowerPoint files if necessary. It also enables real-time collaboration, which makes it great for teams working on important presentations together. Editing tools The Google Slides user interface probably brings to mind PowerPoint, and comes with basic tools for creating slides, formatting text, and adding
animations to your slides. PowerPoint lets you convert data from Excel and Google Sheets spreadsheets into charts, and you can also add pictures and videos from almost any mainstream file type. However, Google Slides doesn't offer the spectacular animations offered by Prez or Slidebean's automatic slideshow
creation, but it does have the same basic options, such as fade transitions and fly-in animations. Its editing tools are also simple, but good enough to create a slideshow that looks professional and aesthetically pleasing while suiting the needs of teams of any size, looking for affordable alternatives to PowerPoint. Models
Google Slides is available to all types of users, so you can create your own slides from scratch or choose from 26 models. You can use them for business and edit them as you want. You can also use models from third-party sites like SlidesCarnival that offer hundreds of free models with striking designs. The template
gallery is small, especially compared to PowerPoint, which has more than 100 templates to choose from. Canva also has a wide range of models with over 50,000. Still, Google Slides is good for any team that's either happy with small basic models or some third-party models aren't bothered by the search. Presenter
Tools Slides has apps for iOS and Android devices that allow you to: phone as a remote control to control presentations when your computer is connected to a TV or projector. You can't do this in PowerPoint without a third-party app. It also offers presenter tools such as private notes, notes, This allows you to highlight
the items on the screen and the basic Q&amp;A tool that allows the audience to access the URL of their device and ask questions of presenters. This is a pretty solid set of presenter tools compared to other options. Canva provides presenter notes, but not a pointer or Q&amp;A. Unfortunately, Google Slides lacks the
behavioral analytics features of the audience, which can be found in more robust alternative plans, and the ability to submit queries and queries, as in Swipe. However, it is still a great free option for any team that wants interactivity with their audience and stores notes in their presentations. Collaboration features Like all
Google business apps, team members can be logged in the same Slides presentation, edited, and commented on slides. You can set permissions according to who sees, comments, or edits your content. However, the collaboration extends past the slide show, as teams can then work together with linked Google Sheets
or other embedded documents. This is a great option for teams working together and wanting to update presentation data in real time. Google Slide Presentation Templates What Google Slides Is Missing Google Slides offers plenty of features to create respectable-looking presentations. Having said that, your
presentation will be very similar to the PowerPoint slideshows that people have been seeing for decades. For something a little more striking, Prezi uses a whiteboard-based design that offers content with dramatic zooms and rotations. What users think of Google Slides users Users are very impressed with how useful
Google Slides is, especially for a free tool. Collaboration features are especially loved by remote teams, and most customers find it incredibly easy to use the platform. There are complaints about some features breaking down when Google gives updates to the platform, but these customers have also noticed that the



company is fixing the issues quickly. We use Google Slides and prefer to create our presentation through powerpoint. We think the interface is very easy to use and intuitive. It will eventually help you create presentations much faster. – Amit Roznak, Head of E-Commerce, AdScale Best PowerPoint Alternative for
Automatic Presentations: Slidebean Slidebean is one of the latest PowerPoint options for the market. Starting at $24 per user per month, Slidebean automatically creates and formats your presentation after you enter text and images. The advanced version even offers analytics. The quality of these slideshows is high,
providing an aesthetically pleasing look. It's our choice for companies that want automated help with great and visual arresting performances. Slidebean pricing You can start slidepaan presentations for free, but you have to pay to share your presentation with others. Plans cost either $96 a year for the Starter version or
$228 a year for the Premium version. Slidebean is an expensive and only platform whose it's not free of weight. Slidebean Features Starter Starter lets you use the core set of slide building tools. You can collaborate on projects with colleagues, showcase your content online, and use the enterprise's library of basic
templates. PowerPoint does not provide this type of community content. Then just add the text and pictures and let Slidepaan use it to layout your presentation for you. Like the free version of Canva, this level forces you to choose a company from a limited color palette, and it can be frustrating for designer-sized users.
This makes the start plan the best for teams that want to create professional-looking slideshows online, but don't need detailed management of how content is displayed. The Premium Premium version gives you analytics, the ability to add your own branding and fonts to presentations, and access to the company's
premium content plans curated by the company itself. You'll also get priority support if you need help in an environment that PowerPoint doesn't offer. However, it doesn't offer a service uptime plan like prez's top-tier version, and it doesn't allow you to ask questions about your audience in real time. That's why this
version of the platform is best suited for teams that want to collect audience insights from their presentation software in addition to designing the content of their presentations for them. Slidebean Presentation Creator What Slidebean Is Missing It's impressive that Slidebean can create slideshows for you, but most
presentations don't look much more advanced than something you can create on Google Slides yourself. If you'd rather spend time adding animations and transitions to yourself, you might want to consider Google's product instead. What users think of slidebean Users love the ability to enter content and build a
presentation around text and images. They're also tearing up the aesthetics of performances that can make even the smallest companies look like today's hottest, hippie startups. However, there are often complaints about bugs and the hic party in the system. Best PowerPoint Alternative for Audience Insights: Swipe
Swipe is a slideshow platform focused on audience feedback; it has a free subscription as well as paid plans starting at $15 per month. In addition to content and transition editors, Swipe lets you manage social surveys during your presentation and track engagement behavior, tell you when, where, and how your
presentation has been viewed, and how long your audience has watched each slide. The swipe is good for companies that want to collect audience information and read insights. Swipe Pricing Swipe's free version lets you make up to five presentations with an unlimited user. Paid plans range from $15 per month for
unlimited Pro plan users to $36 per user per month in a business plan. This puts it in line with other presentation software affordability. Swipe staggered Features for free The free version gives you access to all swipe building tools, but limits you to only five presentations. It also doesn't give you the analytics or ability to
protect sensitive data with passwords, but you can put audience feedback modules on presentations with interactive queries. Users then respond to queries by clicking on the responses, and it is a feature that is supported in both live and recorded versions of the presentation. Currently, you can't query your audience
directly in PowerPoint without a third-party extension. This makes the popular app look old-fashioned compared to the swipe. This version of the platform is good for companies that simply want to try Swipe for themselves and update the paid plan later. Pro Pro Offers an unlimited number of presentations, analytics and
privacy measures for your presentations for $15 per month. PowerPoint also offers analytics, but doesn't offer live surveys in any capacity, which means you need to use another software to manage audience surveys after presentations. Despite its feature series, this version is significantly more expensive than the
monthly cost of either Slidebean or Haiku Deck Pro's Starter version. It also lacks a range of templates for other solutions. That's why this platform is best for companies that want a presentation tool designed for interaction between audiences. The Team The Team edition is $3 more per month, so the cost is $18 per
month. However, the only key difference between it and the Pro plan is that it adds priority support. This means that if you contact the company for help, you will be made to contact a representative before customers ordering fewer floors or service. PowerPoint doesn't offer a similar support option, but if you don't have
ongoing issues with your environment, you probably don't need this level of service. Business This top-level version of the software adds visitor information to help you learn how long users have viewed each of your slides and what time they've viewed your content. This information can be used to help your team know
which customers and partners find your presentations the most interesting. It also offers CRM integration that combines the data from these insights with platforms like Zoho and Salesforce. At $36 per user per month, this is the most expensive tool we looked at. This can make it too expensive for some smaller teams.
Nevertheless, it could be perfect for companies that want to collect diverse insights from their presentations and automatically export the data to CRM. Swipe interactive shows What the swipe is missing Swipe shines by providing interactive audience surveys. However, if you don't need these, Swipe's are not nearly as
strong as the other services we look at. Google Slides also offers a wider range of templates to choose from, as well as Specify more slide activity and structure. What users think of swipe professionals who hold information seminars and other types of presentations love swipe audience survey features. Users also report
that the platform is incredibly easy to use. Having said that, users will feel that it will take some time to get used to the interface. Best PowerPoint Alternative for Mobile iOS: Haiku Deck Haiku Deck is perhaps the best presentation software for editing iPhone or iPad according to PowerPoint options. Although there is no
Android version, it boasts the best mobile app of all the platforms we watch. It even comes with an AI assistant that can automatically add images and formatting. This makes Haiku Deck ideal for iOS users who want to create shows on the go. The free basic version of Haiku Deck Pricing Haiku Deck lets you create a
single presentation. Paid subscriptions start at up to $9.99 per month for the Pro version and go up to $29.99 per month for the Premium version. This makes it one of the most affordable options we compared. The free basic version of Haiku Deck Features Basic Haiku Deck lets you start building presentations on your
computer or mobile device. However, this is more of a trial program than a real, free plan because you're limited to one presentation, but serves as a good way to explore Haiku Deck's interface and its core features. This entry-level package is very simple and you don't have slide privacy controls. As a result, here you
won't find features like custom branding or the ability to embed video like in PowerPoint, but you can still use the mobile app. All in all, this version is not intended for serious business use. The Pro Pro version offers a range of features that would suit 10 established companies, such as custom branding, which is missing
slidebean's same-price Starter version. It also comes with AI assistance from the company's Zuru assistant. This feature can automatically insert pictures and suggest shapes based on text. By comparison, PowerPoint does not provide this type of AI support. Haiku Deck Pro doesn't include features that collect audience
feedback, such as Google Slides, or live survey features like Swipe. At $9.99 a month, the Pro version is ideal for Mac users who want to experiment with unprotected technology and be at the forefront of slideshow building. Premium Haiku Deck Premium gives you primary support, just like the most expensive versions
of Prez and Swipe. It also offers analytics features that tell you the time and location of users looking at slides is $29.99 per month. While this is more expensive than PowerPoint, these features make Haiku Deck feel like a modern solution. However, Haiku Deck Premium still lacks the audience feedback collecting
features that other platforms It also lacks a large template library with However, if you want to better understand your audience's viewing behavior, Premium is worth considering. Haiku Deck Image Library What Haiku Deck Is Missing Haiku Deck's iOS apps have intuitive and full demonstration tools. So it is unfortunate
that there is no Android version of Haiku Deck. Most of the other systems we looked at at at least offer a presentation viewer on Android. The mobile version of Google Slides may not be as stylish as Haiku Deck, but it works on all major platforms and could be better suited for those who want to make presentations on an
Android device. What users think of Haiku Deck Haiku Deck's customers find the system easy to use and very straightforward. The image library that comes with the free version allows even illiteracy users of the technology to build attractive slideshows. However, there are some complaints about the lack of adjustment.
The best PowerPoint alternative to sales and marketing presentations: Canva Canva is a design app that provides tools not only for presentations, but also for infographics, posters, and almost everyone else that you want to do as a ouster. Offering a free version, the service has all the building options for basic
presentations, as well as collaboration features and a library of affordable stock photos. Canva is great for sales tactics that want one stop to build presentations as well as other marketing material. Canva pricing The free version of Canva offers 1GB of online storage for your content. The Canva for Work package costs
$12.95 per user per month, making Canva one of the most expensive services we looked at. You must contact Cava's sales team for an enterprise edition offer. Canva Tiered Features Free The functionality of the free version of the entry level is limited, which is something of an industry standard in the presentation
software. Having said that, you'll still get access to all of the Canva 8,000 models, which is much more than What PowerPoint offers. One gigabyte of data is also minimal compared to the 15GB offered with every free Google account. This can be good for experimenting with a platform or simple one-off projects that don't
require advanced features like custom sizing or using paid stock photography, making it a great option for people who want to use their own images in brochures. Canva for Work Canva for Work offers almost everything your business needs professional business content, such as external font support, custom size, and
access to any stock photo in your Canva library for just $1. There are images that correspond to virtually any possible case of business use, and more are added every day. For comparison, PowerPoint offers only minor library underuse artwork. Canva for Work lacks other systems Its collaboration tools are limited to
internal teams that want to collaborate on presentations or Materials. However, Canva is a great all-in-one design platform for creating effective collateral. If you want an easy-to-use tool that allows you to strongly customize your presentations, this version of Canva pays off. Canva for Enterprise As the name suggests,
Canva for Enterprise is for larger organizations. You need to contact their sales team for pricing, but this level has its own account manager and administrator management, which allows you to set permissions that allow employees to access which features. It also has a 99.999% uptime guarantee. PowerPoint does not
offer such a stand guarantee. Canva for Enterprise doesn't offer concrete pricing like other platforms, which can be confusing for many customers. It is also difficult to recommend to those who want to collect insights from the audience. Still, it's great for those who want a committed business manager to see their needs
when using the product. Canva presentation model Which Canva lacks Canva's main advantage is that it allows you to create other content, such as ads and social media graphics, without having to use another tool. Its presentation builder is adequate, but it doesn't offer animations and fonts that look as good as
Slidebean and Google Slides. If you don't need to make sales collateral, these systems are better choices. What users think of Canva Our readers say that the model range makes it easy to make professional looking models without being a seasoned designer. On the other hand, there are complaints that searching
through models is laborious and that navigating the library of stock photos can be slow. The best PowerPoint alternative to highly focused presentations: Prezi Prezi, which offers a free version, is the PowerPoint option, which takes an unusual approach to a joint presentation. Instead of using slides that you go through
from start to finish, Prezi uses one very large canvas, which the presenter can then browse by zooming in and out of content. The software is great for companies that want to quickly change the focus of the presentation or highlight a key issue on the fly. Prezi pricing You can use Prez for free, but storage is limited to
100MB and your content will be visible to all other Prezi users in their audience gallery. Prices range from the Enjoy version for $7 to the top tier, $59 per month, pro plus plan. Pricing is in line with other compared services. Prezi Tiered Features Public The Public and prez's free version allow you to create and share
presentations in the same evening as with PowerPoint. You can type text, format it, and add pictures as you see it fit your presentation. You can also set up animations between slides. Unlike other presentation tools, however, the software is designed in such a way that You can skip or quickly navigate from content
instead of forcing you to browse a stack of unnecessary slides. Like most others. options, the public edition of Prez limits you to only 100MB of online storage. It also places all your content in the public gallery for everyone to see. It doesn't fit most business use cases, but it could be a viable option for putting together very
basic presentations with non-sensitive data. Enjoy for $7 a month, you can keep your Prezi content private and use it on either the iOS or Android app. You'll also get priority support if you need help from your business, which is better than PowerPoint offers. This version comes at a lower price than similar offers except
google slides. However, unlike Google Slides, you can't crop or touch photos in the app. For this option, you need to update your company's Pro plan or higher. Prezi Enjoy is good for small teams that want key presentation-building features that allow them to create truly unique and audience-tailored presentations, and
for those who can edit images in another program. Pro for $19 per month Prezi includes unlimited storage space and the ability to work on projects offline. This makes it similar to PowerPoint, which allows you to record as much media as your computer can handle. You can also use image editing tools, so you can edit
the graphic before you add them to your presentation. Unlike the Premium version of Slidebean, it doesn't have analytics features or external font support. It also does not have access to a library of stock photos, as it does with Canva. However, if your team finds them theming theming theming presentations with lots of
graphics, this is worth checking out. Pro Plus Pro Plus is designed for larger teams, and it adds to the company's advanced hands-on training when you sign up. Prez staff will personally escort your team members through the system features. Microsoft will not get this opportunity to learn PowerPoint. Prezi Pro Plus is
one of the most expensive packages we've studied and still lacks things like the ability to collect audience feedback. Still, it's a very strong offer. If you want to save yourself the trouble of teaching all your employees how to use the software, you're likely to appreciate Pro Plus. Prezi Flexible performance What Prezi lacks
In the right hand Prezi performance can look fantastic. However, unless you have an eager eye for design, it is difficult to make Prez, which does not look messy and unsent. If you don't have the skill or desire to take advantage of Prez's nonlinear design than the traditional PowerPoint-esque formatting in Google Slide is
a better option. What users think of Prezi users who are store designers love Prez and the fact that it allows them to make presentations that go beyond a joint slideshow. However, ordinary business users find the builder complicated and say that it is difficult to make presentations. Bottom Line Over the years,
PowerPoint has been adapted to cheaper, sometimes even free offers that allow make powerful performances. The fact that these systems are all cloud-based is also a bonus because you can create and edit content on any device. Google Slides is free to use, very intuitive, and has all the editing options you need to
build a powerful presentation. Its real-time collaboration features and presenter tools are very useful, and the fact that you can import templates from a third-party service makes it the best PowerPoint option on the market today. Start with Google today. Visit Google Google
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